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IBM Software Group

IBM/UMHS Briefing
Rational/WebSphere Tools and Servers

June 3, 2005

(Additional presentations, tutorials and technical resources are available at
http://JavaDevTools.com)
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IBM Software Group

IBM/UMHS Discovery Session — May 2005

UMHS Perspectives Gathered
Productivity for expert and novice developers is an imperative

Ease-of-Use for development tools is important

Quality from development to production is challenging
Support from IBM varies and needs improvement

Lifecycle development is needed and partially implemented
Web Services is an important technology moving forward
Workflow tools and middleware are needed and have potential
Open Source tools and IBM tools cater to various communities
Virtualized application server web hosting is needed
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements
» Big Picture
Eclipse platform, WebSphere servers, Rational tools and developer value
= Productivity and Ease-of-Use Enhancements in V6 Tools
JavaServer Faces drag-n-drop J2EE development
Service Data Objects for heterogeneous data access
= Web Services for cross-system integration
Hot deployment and enhanced server-tools integration
» Quality and Lifecycle Enhancements in V6 Tools
> Requirements, Design, Construction, Change Mgmt enhanced IDE Integrations
Quality Assurance and Testing Tools Enhancements
» Workflow tools and servers heritage and enhancements
» Virtualized application server profiles enhancements

» |BM Premium Support enhanced level of service and responsiveness
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements
» Big Picture
Eclipse platform, WebSphere servers, Rational tools and developer value
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Changing Market Conditions Drive On Demand
Business Needs: Addressing Top Business and IT

Priorities
“More than 80% of CEOs
see unpredictable market

forces as the key inhibitor
to growth.”

Source: IBM’s Global CEO Survey, February 2004

= Economic volatility and
globalization

= |ncreasing consolidation
across industries

= Increasing regulations and
industry standards

= Technical realities

C

! Streamline or optimize !

~__business processes

I 5 >

Boost worker productivity | 5%
across company

Improve customer service |GG 54%

<1_ Application Integration | NN 48% D
Bl/Data warehouse | EGB 42%
Security |G 42%

Sources: Outlook 2004: Priorities 1Q InformationWeek Research, January 2004,
Merrill Lynch CIO Survey Results, September 2004
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Transform and simplify software development

Business-driven development

Anjintegrated approach toisoftware developmentithat
alignsiline=oIEhusiness; developmentand operations

[EamsioNMpPreveUSINESSIPEROMAance

Development as a business process

» Align Technolegy:and BUSIAESS » Higher productivity’ - S0%; tinciease
in developer productivity,

priorities
» Improved guality’- 80% feweriotgs

* Improve efficiency and
IESPONSIVENESS o Greater predictability.

o Create innovative products

Software development becomes a driver of competitive advantage

.‘;:!|
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Business-Driven Development
Business Drivers that Guide our IBM Software Development Platform

. L]
Dlscover

® Find reusable assets
within existing
transactions, apps,
& systems

* Model & design
architectures,
applications,
services, etc.

= Store and catalog
assets for reuse

51 Y0 o prejectialures arne
due te poorly'scoped

requirements,

Develop@

* Templates, patterns

& asset-based development

" Transform assets into
reusable components

® Optimize performance
prior to deployment

* Manage teams & the
development process

= Optimize interaction
& procedures

Oy S409%) o reguired ieatuires
and functions make it to the
released product

EI
Deploy |%5

® Quality Assure:
conformance testing,
bug tracking, release
management

= Systems Testing

® Manage runtimes
over lifecycle

“ Performance
monitoring

S2Y0) o PIGJECTS runreVer
time, 51% are over bhudget
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Discover, develop, and deploy assets

= Discover business & technology assets
Prioritize Plan Manage Measure » Business priorities

I BUSINESS » Requirements

PE— | » Middleware and software assets

= Develop at the speed of business

MANAGE ' » Rapid application development

v, CHANGE » Model-driven architecture
r,% AND ASSEITS
<:

Op

» Asset-based development
» Direct-to-middleware productivity

\ = Deploy to closed-loop environments
OPERATIONS DEVELOEMENT » Automated applications deployment

Optimize lterate » Streamlined composite application
management
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The business-driven development lifecycle
Prioritize Plan

Manage

Measure
: <R BUsinNegss o’

Viedelthe

_ BUSINESS DETINE
i Ea

REGUINEMENRLS o

@plimize

Analyze
N DESTAN

VENEGEE CHENEE
VEnEge &%sgets s
]

[IMplEmeEnt

[DERIGY

Operatons

[DEVEIGRIMENT
Optimize
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IBM’s Eclipse Software Development Platform

Integrating Multiple Roles and Development Tools into a single IDE

=== CETTER Software Development Pltform
;__H}?:Eer Independent too and poorly - i —
e T

connected islanc of development

il B o et

-----

Best-of-breed tools and teams working
together in an integrated environment
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WebSphere/Rational Tools Portfolio V6 - Core Roles

Role Description Benefits & Skill Requirements

MIGOIEL e @SS [SsInees = No programming experience required

Business processes to reengineer existing . Can focus on business performance &
Analyst business processes or define new (0CesS P
business processes P
. Uses visual tools to configure = Some basic programming experience
Integration : : C L : :
Developer |ntegrat!on !oglc with eX|st|ng_and new = No J2EE skills required
N applications and humans in the = Expects tools to simplify and abstract
/Specialist : : :
network advanced IT implementation details
J2EE L : .
Application Creates new applications using Java = Focused specifically on J2EE
development tools iImplementation
Developer
Extend legacy assets to new users
Enterprise and enable those assets to be used in = Focused on mixed workload of J2EE and
Developer Service Oriented Architectures (SOA) COBOL/PL1/RPG environments

and as Web services
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WebSphere/Rational Tools Portfolio V6 - Core Tools

Practitioner Role

Business
Analyst

Integration
Specialist

J2EE
Application
Developer

Enterprise
Developer

Previous/Current Product

V6 Offering

WebSphere Bl Modeler v5.1
Entry/Advanced Editions

WebSphere Business Modeler (2H’05)

WSAD-IE v5.1
WebSphere Bl Server Toolset v4.3

WebSphere Integration Developer (2H'05)

WebSphere Studio Application Developer v5.1
(WSAD)

WSAD-IE v5.1 (JCA Tools)

Rational Application Developer - RAD (4Q’04)

WebSphere Site Developer v5.1 (WSSD)

Rational Web Developer — RWD (4Q’04)

WebSphere Studio Enterprise Developer v5.1

WebSphere Developer for zSeries (1H’05)

WebSphere Development Studio v5.1
WebSphere Development Studio Client

WebSphere Development Studio Client Advanced
Edition

WebSphere Developer for iSeries (2H'05)
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WebSphere/Rational Tools Portfolio v6 - Eclipse Base

b : [II:I Extendible
c Platform

c25| 880

col| = = 8—

o c < (OL, R

NHS | Woo

522|853

=@ %)ED ‘IBM / 39 Party’

Products

_ Eclipse 3.0

= All Software Development Platform products install in a consistent and extendable way within the ‘platform’
= First Product installs the Eclipse ‘platform’ as well as it's own product-specific ‘installable units’
= User of multiple tools experiences a single integrated “desktop” IDE

= Reuse of RAD and Eclipse components (‘installable units’) is baked into the design
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WebSphere Tools Portfolio V6 - IBM Rational Software Development Platform

Anélyét Archltect Developer

Rational
WebSphere Application
Business Developer

Modeler WebSphere
Integration
Developer

WebSphere
Developer for
REMENFASERES

ECLIPSE

| ‘?‘

Project Ména er

Deployment
Manager

= The WebSphere Tools Portfolio is part of the IBM Software Development Platform providing a

complete, open, modular and proven solution
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WebSphere/Rational Tools Portfolio V6 - Summary

= Comprehensive tools optimized for WebSphere
= Role based tools aligned with the IBM Software Development Platform
= Core Products

*WebSphere Business Modeler v6

=*Model and simulate business processes, with direct input to IT tools
for implementation

*WebSphere Integration Developer v6

=Build composite apps (service/process choreography) and mediations
based on Web Services standards

“WebSphere Developer for zSeries / iSeries v6

=Undertake mixed workload development, spanning J2EE and legacy
environments

=Rational Application Developer v6
=Model, build, test and deploy J2EE Applications
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements

= Productivity and Ease-of-Use Enhancements in V6 Tools
JavaServer Faces drag-n-drop J2EE development
Service Data Objects for heterogeneous data access
= Web Services for cross-system integration
Hot deployment and enhanced server-tools integration




IBM Software Group

V6 Highlights - Areas of Innovation - Enhancements and New Capabilities

= Lifecycle Integrations (Enhanced Rational/WebSphere Eclipse based Integrations)
> Requirements Explorer View
» Model Explorer View
» ClearCase Views for managing changing artifacts
= ClearQuest Views for managing collaborative activities

» Testing Tools Views
> RAD/RSA Design & Construction Too||ng Enhancements |

= JSF, SDO, Web Services, etc.
= J2EE 1.4/1.3/1.2 and WAS V6.x/V5.x
> Portal/Portlet Integration
= Enhanced Unit/Component Testing
> Code Review and Runtime Analysis for Profiling
= Built-in Coder-friendly UML Visualizations for Class/Sequence diagrams
> Crystal Reports
> And much more...
= New UML2 Engine '
> New code base
= End-2-End UML2 modeling
» Easier GUI development

= Transformations between models and generating Java/C/C++ code
= Software Quality Testing Tools Enhancements (Manual, Functional and Performance Testing) l




IBM Software Group

V6 Highlights - Areas of Innovation - Enhancements and New Capabilities

= Lifecycle Integrations (Enhanced Rational/WebSphere Eclipse based Integrations)
> Requirements Explorer View
» Model Explorer View
» ClearCase Views for managing changing artifacts
= ClearQuest Views for managing collaborative activities
» Testing Tools Views
> RAD/RSA Design & Construction Tooling Enhancements
= JSF, SDO, Web Services, etc.
» J2EE 1.4/1.3/1.2 and WAS V6.x/V5.x
> Portal/Portlet Integration
= Enhanced Unit/Component Testing
> Code Review and Runtime Analysis for Profiling
= Built-in Coder-friendly UML Visualizations for Class/Sequence diagrams
> Crystal Reports
> And much more...
= New UML2 Engine '
> New code base
= End-2-End UML2 modeling
» Easier GUI development

= Transformations between models and generating Java/C/C++ code
= Software Quality Testing Tools Enhancements (Manual, Functional and Performance Testing) l




IBM Software Group

Design and construction tools

IBM Rational
Software Architect

IBM Rational

IBM Rational Application Developer

Software
Modeler

IBM Rational
Web Developer

Eclipse
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IBM Rational Web Developer

Follow on to WebSphere Studio Site Developer
New Rapid Application Development capabilities focused on ease of use

IBM Rational Web Developer

: al Editor for Java for rich clie
eb client technologies Web Ul construction : |
*HTML, JSP, Servle ice Dta.Object (SD) Sl:j
*Struts, JSF Data tools

Database tc Rich Client Ul construction
plore and design datab

Enterprise Generation Language

Web Services Tools

plified 4GL for Web
plication Development XML Tools development tools

User Interface Progr e completion, search, refact
pport (3270, Curses) . nsible Team APIs to suppo
ualAge Generator -> E EC|IpS€ Java Dev Tools Jration (CVS, ClearCase, al
yration Tool others)
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IBM Rational Application Developer

Follow on to WebSphere Studio Application Developer

s and Web Services
. . . rioritization recommendation ba

IBM Rational Application F:jeanalysis

ated test case generation throu
e of test patterns
pool editor for data-driven testing

ized unit testing through a set o
cs in the test creation wizard

E construction tools Develo per
oports WebSphere and

oports J2EE 1.3 and 1.4

[ Component/Unit Test
pid Deployment for WAS v6
grated WAS test environm

J2EE/EJB Tooling

Portal/Portlet Design Tools

al Portal site and page layou
al Portlet layout and preview
rce code analysis for rule : i
lation detection: Globaliza Code AnaIySIS Tools
E/J2SE Best Practices,
ate AP| Usage, Performa . .
guence diagram runtime t UML Visual Editors
performance, thread anc
Je coverage annotation
anced memory leak

diagrams for
uence diagrams for method b

alization
Rational Web Developer 1X/IE diagrams for Databas
schema

amic topic diagrams
RUP Configuration for J2EE adoc integratior
er-defined run-time probe

ClearCase LT
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V6 — Every Top 10 Category Is Enhanced
Adaptable - Eclipse-based Workbench

Automated - IDE Infrastructure (Code, Build, Test, Debug, Deploy)

Accelerated - End-2-End Builders
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Focusing on Ease of Learning

» Learning Guide
= Provides an introduction
> Discusses the value and benefits
= Describes the tools available with suggestions for using them
= Links to other education sources for prerequisite skills

WEB RESOURCES

In addition to information in the Welcome and the Help, the YWeb provides you with tips, articles, updates, and references to industry standards.

Fational Application Developer % IBM Publications
Technical rezources and best practices for Rational : Links to IBM Redhooks and ather [BM publications

Application Developer

LIkL 2.0 JavaSemer Faces
OMG's home for Unified Modeling Language for architecting zun Microzystem's home for advancements in JSF

zoftware Technology

Struts j AL
Apache Software Foundation's apen-source Java iish X- OASIS's Wb portal for XML developers and technologists

application framewvark
S22
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Focusing on Ease of Learning

» Tutorial Gallery
« Easy way to access all tutorials
= Sample Gallery
+ Easy one-stop shopping for samples and their documentation
» Descriptions and purpose identified
+  Setup requirements reduced or eliminated
* One click — make this a project

@ Samples Gallery

Contents

= @ showcase samples
= % Auction Application
E % Construction
© portal Application
© weh Application

Studio Categories

Showcase
Samples

B irati
Sample %pph[atlﬂﬂ samples The Samples Gallery provides pract
Applications ElE samples for application developers.
Technology “ portal
Samples Weh Showcase samples are the most extensive, robust
= %EGL provided. They consist of end-to-end applications th
sub categories @ web Exercises 'F'? c‘? best practices for application development. They are
too... _ applications that are developed using a combinatior
() Pizza On The Weh for design, development, and testing. These sample
® Text User Interface need some configuration in order to run on your sy
2 & Technology samples SEtur? in?tructiDHS can be EICI:E.SSEI:I frn:u.m the sample
%Java Application samples are working applications creats

- more than one tool or APL They illustrate how diffg
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Eclipse V3 enhancements

More responsive User Interface
= From enhanced concurrency support and asynchronous task management

New look and feel
= Based on user feedhack

Reduced User Interface complexity through progressive disclosure

» Capabilities support enables a tool to filter the views, wizards, actions, etc available initially
available to use

= At trigger points more advanced function is revealed

= Users can adjust the amount of initial function
Teams can share preference settings

= Expanded user settings/preferences support with multiple scopes
Most existing V2.x Eclipse tools work with Eclipse 3.x and RAD V6

= High degree of binary compatibility between V2.x Eclipse plug-ins and Eclipse V3-based
products

» Please consult your vendor to determine the status of the tools you use
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J2EE 1.4/1.3/1.2

» Web Services and XML support
« Standards / Portability - XML Schema definitions for all deployment descriptors
s JAX-P 1.2 - New properties for XML parsers
«  JAX-R - XML registry API
« JAX-RPC - APIs for representing WSDL-based services as RPCs in Java (&vice-versa)
» JSR 109 - Web services programming and deployment model
s SAAJ 1.1 - SOAP Attachments API for Java
= Other
«  Servlet 2.4
« JSP20
« Extensible deployment descriptors
» Request/response listeners
» Expression Language
» Simple Tag Extension
= JDBC 3.0
» Meta data and cursor support
= Messaging
« EJB21
» Typed message beans (used for any inbound JCA including pluggable JMS provider)
= Timer service Web service end-point support
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UML 2 Diagram Editing — Visually Browse/Edit

» Expanded UML editing
» UML class diagrams for Java, EJB
» [DEF1X, and IE editing for data objects
= Edit/refactor through diagrams
* Browse, Navigate and Query through diagrams
> Topic diagrams for automatic diagram creation
> UML 2.0 interaction diagrams for

visualizing method bodies | o = e
= Javadoc integration for diagrams Tj’ﬁ Iw,ﬂ;, L
> Improved printing support b i ;%: '
= Usability and workflow improvements G"“‘:l:“m”, oo | o
«  Assisted diagramming TS J e -
Browse diagrams b *.*""'::‘fm_mm Im-w %'g.n”
In-diagram editing | Tr:il :;El "TE' ;HFE
Diagram Explorer ) K :i
= Low overhead way of adopting UML i J"”‘"' =

and visual development
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J2EE Development Automated by JSF

Input =» Process =» Output

* |Input
 Constructing web page forms, formatting, validation, etc.
« GUI widget richness

+ Calling appropriate “Action” when button pressed, etc.
+ Passing data to business logic

» Processing
« Integrating to web services, databases, backends, biz logic, etc.
= Maintaining user session and application state information
» MVC layering, page flow and business logic modularity
* Qutput
» Forwarding control to results screen/page
« Displaying data, GUI controls, formatting, etc.
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Developing Richer Thin Client Applications, More Quickly
» Drag-n-drop development of J2EE applications (No Coding Required)

a 1BM WebSphere Portal - Microsoft Internet Explorer
File  Edit

A Back + = - @ ﬁ | QSBarch ﬁFavorites @Media @ | %- % a

Wiew Favorites  Tools

Help

Links aCustomize Links @IBM Business Transformation Homepage @IBM Business Transformation @IBM Home Page @IBM Internal Help Homepage:

Tanped
Panels !-

Spreadsheet
conitrol

Address I@ http:fyclideskiop. raleigh.ibm.comfwpsimypartal] scrfLoggedIn
GODglfvl j &)Search ‘Weh @Search Site | @News | ﬂPage Info - LI|:- -

ing Account

Accounts Bank Accounts =0 Account Details

Banking Accounts

Account Number: 96666

Trans # Amount Date Type Expense Purpose
96,666 Credit 2,000.00 355 72,62 Z000-11-06  Visa Taxes
74,444 Checking 1,432.44 356 31,78 Z001-06-16  Visa Entertainment/Travel
85,553 Saving 2,567.56 357 £1.02 2000-08-25  Wisa Clothing
= 2 358 21.75 2000-01-25 Visa Transportation
359 13.01 Z2001-03-24 Visa Telephone
Database 360 24,51 2002-01-20  Visa Transportation
Query 3nl 15.87| 2001-02-11 Uisa Food
362 13.81 Z001-05-23 Visa Telephone
Transfer Funds -0
< =
Make Transfer
From: |Select Account =l Expense Allocation
To: |Se|ect Acoount =1 Wiendical Dartal
) W MortgageRent
\Welh Amount: 4] Fond
. W GazBeotric
Service hore infarmation about Transfers. " Clath
B Insurance
Continue | W DependentCare
0 Taxes
> B Entertainment Travel
Gl'aph | ng Transportation
M Telephons
Contrels -

l_l_l_ (28 Local intranst A
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Simplifying J2EE Development

» Database development drag-n-drop ease-of-use 12

[= Data

=T Relational Record

& lavaBean
.Q Web Service

i Relational Record List

> E‘ﬁ AFP Page Data o x
- =-[3 Tables = E allCustomers (CUSTOMER) A
- APP.ACCOUNT -8 cusT_D (1nt)
l=::] APP. CUSTOMER - g MF'E:;M éft_riﬂg) =
; b Fin
'"E APP.TXFUNDS .8 LASTNM[[stringg)) N
i @ ADDR (String)
B CITY (String) Z
V —t

[= Data -

Existing Web Services

= Relational Record

) Relational Record List
@ JavaBean

@Web Service

MName |

accountmgrproxy
dotsfastweathersoa...

\ O o \ O o

» Portals drag-n-drop ease-of-use i .

DEME%@

+ Add portlets

Showing 21 - 26 of 36 |14] [4] Page 4 of 4
Select Portlet Title
r EZ]SFPortlet? portlet
r TransferFunds pertlat
r AccountBalances portlat
v CustemerAdmin portist
r Customerlpdats portlat
r TransactionHistory portlet
Showing 21 - 26 of 36 |14] [4] Page 4 of 4

O o
= Web Services development drag-n-drop ease-of-use 12

Eletiy, your wansactios scsdty for all vou accousts sppean bekos

| Tamd Type Aert ¥ Ameant§

Dresits
IGSEEESHI DEP 4 $3,000.00 Depostio Acces 4
ICRSAREUTRIA0 WDR 3 $3,00000 Wikl from Aces® §
1OBSEEEPIONE DEP 4 5200000 Depeskio Accst 4
TCSESRESSIRI WDR D 52,0000 Wildrawal from Accst 1

Gad 1

Frwss | fiom
ik i

P ey
b o

\ W 2

Choose a method:

Itransfer['_i ava.lan&mteg er,

Add new Web Service... |

\ O 4

EZISFPortlet portlet

CustomerAdmin portlet

PR e B o R

Customer Admin

Cust_id Firstnm Midinit Lastnm State Zip

|®1 |.nrt||ur |A ‘Plat\'num |IL

60506
|®;_ |Bet5y |B ‘G\Jlden |IL |60606
|®3 |char|re |c ‘Si\va |IL |60606
|®4 |Dem'se |D ‘Coppe( |IL |60606

[ [reess > [ o
| M Meu
T
Make Transfer
From: |Se|ect Account =1
To: |select Account =l

Amount: $|
More information about Transfers.

Continue |

.. CustomerUpdate portlet
Customer Update

[ e |
N et
oo T
e
asom: | [t
e
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JSF Tool Views in RAD

© Web - customerlist. jsp - IBM Rational Sofiware Development Platform

It~ &
¥

File Edit Toolbar Insert JSP Format Table Frame Page Tools Mavigate Search Project Run Window Help

o e | BE ($-0-Q | @ |5 e

]

+ | Nane

»»

T @Web

Pprgject., 2% T8

@ Navigation - MyStora | (@ eb Browser (E customerlist.jsp 22 g

BB v
[ Erterprise Application 4|
[]---EE Application Client Pro-

(3 Conmector Projects
4
E

¢ [§ EB Projects
=1L Dynamic Weh Project
-1 MyStore =
[ Weh Site Navic
Deplayrnent De
#-( Java Resources
EIEb YiebContent
% ---[Eb crystarepor
- META-INF
---Eb theme
) (5 WEB-INF
ER . T T
i | | ]

customerlist. jsp - custmerlist. jsp El~ | hioutputText = | Standard ¥

))1 = E

EbpPal..

[EUHTML Tags

)

.........

Hamephane ™

(£ 35P Tags

[ Crystal Reports Fa...

(£Fares Components #

- Data Tahle

EPaneI - Menu Bar

= Command - Button

i Command -
Hyperlirlk

v

1 il

|2 Page Template

[ \Weh Site Navigation

2 Data *

|0y EMAILYDY MHOMEPHONE) &

P PR A
£ il ] ¥
Design Source|Preview|
ElProperties 2 QuickE\dit|Servers|Prob\ems| 2~ ~0

Fay A

Id: | Farmat —

Style: Props:

sbe hioutputText Classes: [outputText
- ] M |

|| (S EIB Session bean

A \Web Service

EfiRelational Recard
Fj Relational Record
List
@ JavaBean

= Simplify J2EE development for non-Java programmers and VB/MS.NET developers

s

= Enhance Web Application Development for J2EE experts

Accelerate GUI, Web Services, Database, Portlet and MVC development
= Visual drag-n-drop development of Ul, events, actions, page navigation, etc.

- {
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Service Data Objects (SDO):
Unified Access to Heterogeneous Data Sources

Read/

» Provides a common Update

programming interface to access RDBMS Data
. Medlator ---------- >
data from multiple s

heterogeneous sources
» Supports both static
and dynamic data APIs
y Client 4
» Supports connected and SDO
: . DataGraph
disconnected operation
= Decouples application code from

data access code JCA & Other
Data Mediator
= Designed for use with tools to Services
Increase programmer People Soft
productivity Query data sources, create data graphs containing

data objects, apply changes back to the data source

Service Data Objects (SDO) is a specification created by IBM & BEA,
submitted to JCP as JSR 235 in December 2003. Expert Group Formation Stage, not part of J2EE yet
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Java Beans JONENEIEERS Client Data

Consuming a Web Service [t %™

22 accountmgrproxy (com.myco.bank.ejb.Ac it

& userProfile {com.myco.bank.user.Userpro| =& @ Web Sendcs and & mathod. IQ
- " I A] accountMumbers (Service Data Object)
No Coding Require -
| ]
Scripting Variable L | Coss |
= - . spoountmgrprosey coumLmyoo. bank. ajb. AccoustMgriromey
eert | A . doasfnstvenatherscapprosy com.serviceohjects. v, DOT SFashiWeatherson...
[ EJB Session bean tempsaraturaportiypeproey gt amepthods. v, TamperabarePort TypeProy
Relational Record List
| need . D
={3 Relational Record .uid_]
® JavaBean —
Salect o mathod
1
o - . [g-lh’\'ualhrr'ﬂrﬁ e lang. String, java. lang. String]) el |
Developer WEb Appllcatlon oEfWeaherfyZip] |ava, lana. 5aring, jave, lang. S

geteatherByCityState] javn. lang. String, jova. lang. Strng, . lang. String]
getveatherBy Pl lang. String, java, lang. 5iring)
getWeatherHistanealByTio | rve. ang. S e, e, lang, String, jva. lang. Sering, ml
getWWeatharBy VWO D rve lang Siring, jeva. lang. String |

(Service Consumer) @ /4 \

Finds Required Web

Service @

uUDDI
Registry

- Brash | cancel
Starts Developing

el )

Uses Web Service Proxy

Web Application
Calls Web Service,

eb Service

@ Invokes Web Service Proxy

© Web Service Discovery Dialog

v
, . \ Back Forwand Stop Refresh Home
WSDL @ Generates Proxyl Web Service Discovery
@ P DeSCFIbeS WEb .( Click on a link to begin searching for web services.
\ SerVICe Weh Services from a LIDDT Registry
Downloads WSDL
*URN Search for Web services by name or key in a public or private UDDI registry.
*Methods

Weh Services fram a known LRI

Search for Web services using a URL to a document.

*Parameters
\_ J

Weh Services from your workspace

Search for Web services deployed and running in my current workspace.

1Good Note: A Java app/component can be generated (a.k.a Web Service Proxy Bean) that can
call existing Web Services, including: web services accessible JavaBeans, EJBs, database
queries, URLs, Microsoft .NET web services, any web service on the internet, etc.
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*% Project Explorer X » = 0| & End2EndPag... | & BankHome.jsp
N N - #-7Z Enterprise Applications ~ o
B u I | d I n g a We b S e rVI Ce Eﬁ Application Client Projects
(4 Connector Projects
=& EIB Projects Definition
. . 1 122 AuctionV60EIB
No Coding Required! -2 e s
" I@ Deployment Descriptor: BankEIB
=48 Session Beans

l =Y AccountMgr
i@ Entity Beans Mews ¥ s
! =
1 EMESSEQE'D”"E Open hccountMgrService
Java Bean 1) Maps . , » AccountMgr
l ﬁ ejbModule e |- wsdlsoap:addrass
w22 End2EndEIBWebServi Deploy

-2 End2EndlavawebSer IETEE L oo Create Web service
139
D L End2EndWeb | Endpoint Enabler L

i FE WAlnkh O RMousdaak Properties Alt+Enter

Legacy Systems
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Developer
(Service Provider)

UDDI

Registry Wizard @
Generates
WSDL 4 (WebSphere Appllcatlom
@ "WsbL (| ) EAR ) Server
_ *Describes Web +Contains A

Publish Service Service Bean in @

*URN WAR - > \-I(\i?::ains Servic!
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\_ Paameters ) \_ y ' Servlet

N\

1Good Note, a Web Service can be built from a variety of artifacts such as
JavaBeans, EJBs, database queries, etc.
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V6 “WebSphere Rapid Deploy” (WRD)

= To simplify the development experience for WebSphere applications by:
=+ Increase the seamlessness of the iterative Build/Test cycle

» Reduce or eliminate server restarts
> During initial artifact creation (i.e. create Java, EJBs, Web Services, etc.)

= During iterative build scenarios (i.e. coding the logic in Java, etc.)

= To simplify the deployment experience for WebSphere applications by:

» Automating the process of installing an application on WebSphere

= Reducing the amount of information that must be configured manually on
WAS (i.e. Datasources, etc.)

» Automating the process of activating incremental changes to an application
on a running server (i.e. Add/Change code/configuration of an application)
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Dynamic Development (Avoiding the “RESTART” Situations)

= Two main stages in RAD V6 dynamic development

+  Creating New Artifacts
+ Changing Existing Artifacts

© AUTOMATIC hot re-deployment of changes
© Manual quick APPLICATION level restart

@ Manual SERVER restartuick app level restart

WS Rapid Deploy (WRD) Dynamic Development Scenarios

Development Activity

WASSA WASE.D

Create EAR Project

Create Web Project

Create EJB Project

Create EJB with Logic

Change EJB

Create JSP

Change JSP

Create JavaBean in
VWeh Project

Change JavaBean in
\Web Project

Create JavaBean in
regular Java Project and
Reference from EJB or
VWeb project artifacts

Restart Project EAR
Manuall

Restart Project EAR
(Manually)

Change JavaBean in
reqular Java Project

Create Web Service
(Exposing a JavaBean
or EJB)

Change a Web Senvice

Restart Project EAR
Manuall
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Component Test Automation

» Enable easy creation, execution, and maintenance of dynamic unit tests
of J2EE components including:

G » Java classes (J2SE 1.4)
® ° EJBs(1.1,2.0and 2.1, supporting both remote and local interfaces)
@ ° Web Services (J2EE based, and .Net Web Services)

» Based on the JUnit framework

» Provide testing guidance
« \What to test first based on static metrics

» Automated test case generation
+ Based on test patterns

» Data driven testing

» Automated regression testing

= |ntegrated with Code Coverage

» |mplementation of the OMG Testing Profile
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Code Reviews

Analyze Project/Workspace to find problems of
various types:

» Globalization

» J2EE Best Practices
« J2SE Best Practices
s+ Private APl Usage
» Performance

= Naming Conventions

Produce interactive reports with violations and
metrics

Provides explanations, examples, and quick
fixes for problems

Allow users to create, enable and disable
validation rules

Allow users to create their own rules based on
rule templates

»  Complete Code Review (200+ rules)

«  Quick Code Review (34 rules)

[[rm]|
I

New...

Lo
m
o
g

Remawe

Coding Style {14 rules)
Design Principles (5 rules)
Globalization {47 rules)

125E Best Practices (&5 rules)
Maming Conventions (2 rules)
Performance (26 rules)
Private API {4 rules)
Structural Analysis (& rules)
(C7 Breakable (2 rules)

[
HEERRREE
EODEBEREDE| 5

(3 Cydic Dependency (2 rules)

[+-[#] £3 Hub (2 rules)

Problem |Exam|:bles| Soluh’nnsl Properties | Resource Filters

[ =T

i

Expand All

Collapse All

5 Avoid components that depend on > 10 other components
5 Avoid packages that depend on > 10 other packages

Problem category
Structural Analysis : Breakable

Problem name
Avoid components that depend on = D other components

Description

A Breakable is & component that has many immediate u:_.!ep_ende_ncigs. Such M

% = [¥]2 Memory (13 rules, 13 enabled)

----- ™ Always call super.finalize() in the fine
----- ™ Avoid calling finalize() unless in the fi
[*]™ Avoid declaring finalize() public

™ Avoid returning from finally

™ Avoid the throw statement inside of
& Avoid instantiating unnecessary temp
& Avoid java.lang.String + operator in |
& Avoid calling java.lang.Runtime.gc()

& Avoid calling java.lang.Runtime.runFi
& Avoid calling java.lang.Runtime.runFi
& Avoid instantiating Booleans using ne
& Avoid instantiating Strings using new
& Avoid using static collections v

I[<

B

I[=]

[=

[

=]

<J[=

[«

[

[

|~
|a

MWove rule... |

Show Search onl
Expand All |

Export...

Import... |
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Runtime Analysis ..

= Sequence Diagram, Method Invocation, heap, etc. views in Profiling Perspective
= Shows the Execution flow of the application

> User can drill down from sequence diagram into the application code or launch other Performance
Analysis views (e.g. Method Statistics)

m Sequence Diagram: Object interackions [ <monitoring= unknown [ PID: 3692 ]] @\
WBACCoUntAChiviby i Programringodel i —ustomerBean l Programringfode] I AccounktBean I AccounktEean i
G 1513428213 G -1887077195 T 1869676833 [G) 232936512 C— -305125614 5 -305035528
B ACcounkAackiviby Programmingrdodel CusktomerBean Programmingrodel AccounktEean AccounkBean
= ==
I=
L}
. = :
% AT T v x QS =k & e & x
Filter: | [V Case sensitive [1____13n___Ira___ 10z E 7 oI B
=Class Mames | | Package | Ease Time | Average Base Time | Cumulative Time | Calls | Calor by: IActive temary VI
Thread java.lang 0.000000 0.000000 0.000000 0 DU
[ StringBuffer javalang  Sa  0.364748 0.060791 5y 0364748 a4 6
String @ java.lang 0.000047 0.000047 0.000047 1 Class Mames Class Instances
Dbject java.lang L ,000000 d,000000 L d,000000 L a PerformanceE sample I -
[+ LocalizedPrint. .. comiibm.., &4 0532924 01065585 &= 0.532924 =4 5 java lang Thread ]
[+ Launcher$app. SUM, MisC 0.000000 0, 000000 0,000000 0 ) F' £ ]
- I & |—"—|_.+|:I-:i4 e s 5 E SUn.aWt. DS[ Ventuueue
Inputstrea. .. java.io %4 0.009083 0.004534 4 0.009068 Ta 2 iava.awt EventDispatchThe —
[+ Inout §a  0.015463 0.003867 %4 23350155 S 4 sun.awt Seresnllpdater
& % g lang.ref. FinalizersFinaii INEGG_
[HDate jawa.utl Sy 0.003361 0.000840 =4 0.003361 =4 4 1ava ang.rel.minalzershinal
ClassLoader java.lang 0001030 0000258 0.001030 4 iava lang ref Reference$R I
[H Eufferedreadsr java.io Sa 22282958 5.570740 S  zz.zezose a4 PerformanceExample$2
[short 0,000000 0,000000 0,000000 i PerformanceExamplel |1
[ohject 0,000000 0,000000 0,000000 ] PerformanceExampled2
[lang 0.000000 0.000000 0.000000 0 [int |
[int 0.000000 0.000000 0.000000 i [long |
[Float 0.000000 0.000000 0.000000 0 [short |
[double 0.000000 0.000000 0.000000 0 java awt Container |
[char 0.000000 0.000000 0.000000 0 [char |
[byte 0.000000 0.000000 0.000000 i o vk Crmee, | _lll
[boolean £,000000 0, 000000 0,000000 0 11 3 i 3
|PerformanceE sample : 1 live, 1 total instances, base time: 13.939785, cumulative time: 18 453854, number of calls: 2
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V6 Highlights - Areas of Innovation - Enhancements and New Capabilities

= Lifecycle Integrations (Enhanced Rational/WebSphere Eclipse based Integrations)
> Requirements Explorer View
» Model Explorer View
» ClearCase Views for managing changing artifacts
= ClearQuest Views for managing collaborative activities

» Testing Tools Views
> RAD/RSA Design & Construction Too||ng Enhancements |

= JSF, SDO, Web Services, etc.

= J2EE 1.4/1.3/1.2 and WAS V6.x/V5.x

> Portal/Portlet Integration

= Enhanced Unit/Component Testing

> Code Review and Runtime Analysis for Profiling

= Built-in Coder-friendly UML Visualizations for Class/Sequence diagrams

> Crystal Reports

> And much more...
(= New UML2 Engine : '
> New code base
= End-2-End UML2 modeling
» Easier GUI development

= Transformations between models and generating Java/C/C++ code
= Software Quality Testing Tools Enhancements (Manual, Functional and Performance Testing)
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IBM Rational Software Modeler

IBM Rational Software Modeler gre
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ensive printing
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munication, Component,
ClearCase LT posite Structure, Deploy
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Support
ymatic diagram generation
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IBM Rational Software Architect

tomatic anti-pattern
attern detection
chitectural discovery
alysis, metrics, and
ability reporting

tomatic diagram genere

ttern content
ttern/Transform authori
mework and services
tensive open API
a-based “scripting” for
ensibility
ML and XML based da
raction and reporting

IBM Rational Software
Architect

Java Structural Analysis

UML Language Transforms
Software Modeler

C/C++ Development Tools

Application Developer

RUP Configuration for SW Architects

ClearCase LT

ple UML-to code transforms

Java and C++

b diagram editor

designer
b Services development too
abase editing tools

3 development tools
L code editors: EJB, Java, L
ic Analysis
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= Simplify creating
UML2 diagrams with
contextually
appropriate UML
element creation, via
popup toolbars

= Visualize Java code
using dynamic code
introspection that
provides hyperlinked
diagrams (Class and
Sequence diagrams)

= New custom views
to improve the
editing experience
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Visualize Java Classes, Relationships and Method Bodies

= Facilitates understanding and application’s behavior by providing visualization of

detailed code
» Diagrams can be integrated in Javadoc reports

“Topic” diagram for

| P s method is " >
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Patterns and transformations

Transformations can be authored to Patterns can be authored/applied and
create traceability links between the used as recipes or building blocks to
source and the target of the refine a model or implementation at its
transformation. level of abstraction.

Transformations

. Domain Patterns
Model-to-Model ', Domain Model
Transformations l

) Application Model

A
Model-to-Code l
Transformations = Implementation

—

Application Patterns

|

Implementation /
Code Patterns

Suialled |euolounS

Rule/constraints-based
transformations can be authored to
transform models in a batch style
operation. Transformations are
authored using Java and the Eclipse
PDE.

Transformations can leverage
functional patterns when they execute.

In a future release, the patterns
capabilities will be extended to the
implementation level (ex.: J2EE
patterns).
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements

» Quality and Lifecycle Enhancements in V6 Tools
> Requirements, Design, Construction, Change Mgmt enhanced IDE Integrations
Quality Assurance and Testing Tools Enhancements
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V6 Highlights - Areas of Innovation - Enhancements and New Capabilities

= Lifecycle Integrations (Enhanced Rational/WebSphere Eclipse based Integrations)
= Requirements Explorer View
= Model Explorer View
* ClearCase Views for managing changing artifacts
< ClearQuest Views for managing collaborative activities

= Testing Tools Views
» RAD/RSA Design & Construction Tooling Enhancements

s JSF, SDO, Web Services, etc.
« J2EE 1.4/1.3/1.2 and WAS V6.x/V5.x
s+ Portal/Portlet Integration
« Enhanced Unit/Component Testing
= Code Review and Runtime Analysis for Profiling
« Built-in Coder-friendly UML Visualizations for Class/Sequence diagrams
s« Crystal Reports
s And much more...
= New UML2 Engine '
= New code base
« End-2-End UML2 modeling
+ Easier GUI development

« Transformations between models and generating Java/C/C++ code
= Software Quality Testing Tools Enhancements (Manual, Functional and Performance Testing) l
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Roles Accelerated By Rational Tools
IBM Software Development Platform

- He VI Y
Analyst Architec Developer Tester

$

Project Mgr
IBVI'S EClipse Software Development Platform
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[[rm]|

Existing Tools In WSAD V5.x and RAD V6

Phases
Disciplines Inmpl:inn‘ Elaboration Construction || Transition
Business Modeling \ |
Requirements oy
UML 2-way Modeling

TN /
Analyst ; Architect

na 5 sig
J2EE, Web Services, JSF, SDO... Irmi plementatluﬂ
Unit Testing, etc. IE;u
Automated J2EE Packaging EEPICI':"I'I'IEHE

» Developer ;

Tester
Configuration
& Change Mgmt
Project Management -
Environment i ?
Simplified Packaging and Names ¥ a
V4 & V5 R\;ﬁD Project Mgr
WSAD .
(Rational App Developer)
RSM
Rose XDE (Rational SW Modeler)
RSA
WSAD +XDE| o tional SW Architect)

IBW'S Eclipse Software Development Platform
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!!El

New V6 Integrated Views/Perspectives

Phases
Disciplines Inmpl:inn‘ Elaboration Construction | Transition

Process Modeler usiness eling :
; N

RequisitePro Explorer Views Requirements Analyst ; Architect ;Developer ; Tester

Analysis & Design

Implementation

Functional, Manual, Performance IE;u

Deployment

ClearCase Explorer Views & Change Hgm'

ClearQuest Explorer Views ect Manageme

Environment i ?
Simplified Packaging and Names ¥ a

Vd & V5 V6 i
i Project Mgr

(Ratonal App Dercloper) IBM'S Eclipse Software Development Platform

(Rational SW Modeler)
RSA
(Rational SW Architect)

WSAD

Rose XDE

WSAD + XDE
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Lifecycle Tools are Integrated as Views in V6, — Stremsrrmremee

|ClearCase petspective

|C|earQuest perspeckive

|Funu:tiu:una| Tesk perspective
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V6 Highlights - Areas of Innovation - Enhancements and New Capabilities

= Lifecycle Integrations (Enhanced Rational/WebSphere Eclipse based Integrations)
> Requirements Explorer View
» Model Explorer View
» ClearCase Views for managing changing artifacts
= ClearQuest Views for managing collaborative activities

» Testing Tools Views
> RAD/RSA Design & Construction Too||ng Enhancements |

= JSF, SDO, Web Services, etc.
= J2EE 1.4/1.3/1.2 and WAS V6.x/V5.x
> Portal/Portlet Integration
= Enhanced Unit/Component Testing
> Code Review and Runtime Analysis for Profiling
= Built-in Coder-friendly UML Visualizations for Class/Sequence diagrams
> Crystal Reports
> And much more...
= New UML2 Engine '
> New code base
= End-2-End UML2 modeling
» Easier GUI development

= Transformations between models and generating Java/C/C++ code
l = Software Quality Testing Tools Enhancements (Manual, Functional and Performance Testing) ' |
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Software guality tools

IBM Rational Performance Tester

IBM Rational
Functional Tester

IBM Rational
Manual Tester
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IBM Rational Manual Tester
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IBM Rational Functional Tester
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IBM Rational Performance Tester
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Key software quality activities

Deployment
Maiager

DERNERS  [EURCHONEAINESINEGAG TIESIIDER]GYAV ONIte);
I Communication - Integration - Investigation I
Business Anti-pattern Programming rule Manual testing I Monitoring
process and detection inspection :
requirements Functional and
quirem Architectural || Component testing regression
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control L : testing
Reliability analysis
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testing

performance
validation
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Test Management: Rational TestManager
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page wil display

2 Click on "Explare our Storefront” Page with [
Recammenier
R’ Selection and
Catalog and Order
3 Click on the "Catalog” button Page with list of [
CD's avalable wil
4 e Inthe Search field, select *Composition” then click the | CD's display order cd
Search hutton wil change to new
B “werity that the order of CD display b5 correct Sart order vl Pass
v reflsct the order in =]
[the attached
5 ot VSt i Pt o b [Sert el P e =]
Operation

Done | [l' ‘Shaw Oy Verification Paints alFass |

Cone Hep |
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Design: Architecture Discovery, Analysis and Control

hitect

= What

el Navgle Seach Proied Fan Wom Peb =
ik ][] se-e-a-

. . nBlorer oo BgE w || Wekome ([ Temporsey Dingenm
» Architecture discovery e ==
» Anti-pattern detection shom
» Anti-pattern control L | - .
= For AR -
» Architects using Rational Software ("5
Architect .
= [R Lo Mol e
© Why T
» Assurance of structural integrity | L
before evolution of complex, R = m—
fragile interdependencies i =
=
e
| s
i
B:
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Implementation: Code

= What
» Validation of code rule compliance
@ J2SE/J2EE Best Practices
@ Coding style
@ Naming conventions
@ Design Principles
» Quick fixes and repair guidance
= For

» Developers using Rational Software
Architect or Rational Application Developer
for WebSphere Software

= Why

» Painless reduction of developer errors
before integration efforts cloud defect
sources

Review

Rule vielation
Underliined In the

code editor

nFailure.java - Eclipse l?[alfonn

factor Mawvigate Search Project Run  Window Help

- S-|® 2| [

P e -

[#-[d] Protectable.java
[4] Testjava

- [d] TestCase.java

[ TestFaiure java
[+ [J] Testlistener java
- [4] TestResultjava

[4] Testsuite.java

il JRE System Library [j2re1.4.1_05]

actual= fRActual.substring(i, k+1);
if (i <= end

- er w || J] TestSuite java [ r _risonFailure. java X] ™ Code Review Details x

Bylle = & ‘ By /e strings ] Problem |Enamﬁes| Solutions |
% =T Junit if <i&s k<i) i =
== =@ junit.framework. expected= fExpected; Basic information
Tl #-[J] Assert.java actual= fActual;

[ AssertionFailedError.java } else {

i ted= fE ted.substri i, +1): Problem category
4] comparisonFailure.java expecte xpected. substring (i, J+1):

Globalization : String Handling

- expected= it}
- actual= ",.."+actual; Broiesy e
' Avoid using java.lang. String _indexOf (}
= for multilingual strings
inj if (i < fExpected.length()-1) = )
- expected= expected+"..."; Severity
- iE.ik. 5. fActual.length (ol High
- actual= actuals",.. . ":
:eturn Assert.format (super.getMessage|() dDK
) ) ) ‘ Derbdam in B S5 1 4 1 Tivadin MM
1 (€] Bl
[&] m ] Outine | Ant |Cod N wview Details |

@ Code Review: ComparisonFailure.java

B x

[#-(=* Globalization:Character (Score 20)
2 lobalization:String {Score 40)
[Unresolved] ComparisonFailure.java:38 Avoid using String charAt
[Unresolved] ComparisonFailure.java:38 Avoid using String charAt
[Unresolved] ComparizonFailure.java:44 Aveoid using String charAt
[Unresolved] ComparisonFailure.java:44 Avoid using String charAt
[Unresolved] ComparisonFailure.java: 57 Avoid using + operator
[Unresolved] ComparisonFailure.java:58 Avoid using + operator
[Unresolved] ComparisonFailure.java:62 Avoid using + operator
[Unresolved] ComparisonFailure.java:64 Avoid using + operator
Maintenance:Style (Score 25)

tugtsl Analysis:Classes (Score 10)

Package Explorer J Hierarchy

RUIENIE) e
Jory/ille

~

>

RIS
ISEV

Wiy [ Exanngle /

rlowW to il
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Component Test: Verify component functionality

= What

» Automated unit and API testing with
automated data generation

» Statistic-based test prioritization
guidance

» Automated stub generation

= For

» Developers using Rational Software
Architect or Rational Application
Developer for WebSphere Software

= Why

» Early detection and removal of
functional deficiencies often masked
by system level errors

arTestBehavior. java - IBM WebSphere Studio Application Developer

efactor Navigate Search Project Run Window Help

[BEIES

BB -%-%-||s]%c->-B %%

B TSt T vigatar w x || |welcome I@BldHe\perTEstEEhawUr‘]ava x]
SR [ \ = o public void testMethods() throws Throwable ¢ |
&5 Auction BidHelperLocal oneBidHelperLocal 1 = null;
& AuctionEJB {
B AuctionE BB oneBidHelperLocal 1 = oneBidHelperLocalHome.create () :
£ T& AuctionTest ¥
{z= Behavior {
& Ru Integer itemTypeld = null;
= Stub Long bidimount = null;
. [ Test Suits Integer bidIncrement = null!
a8 Auctionieb Long waxBid = null;
Integer userID = null; -
int currenc v = 0:
oneBidHelperLocal 1.bidItem|
itenTypeld, =
bidamount,
bidIncrement,
maxBid,
userIDh,
ccccccc v =]
x
Test avigator Exccution Havigator el Type default
| ™ oLT
o a 5
g= Bufl 318« 0 x oneBidHelperLocal_1 = oneBidH... 6= &)
i . [= oneBidHelperLocal_1.biditemn( it... (= & &
Heis ;
= itemTypeld -7 Intager 100546
(=@  BidHelperTestBehavior =miyp & d
] bidamount ﬁ: Lang 100
& oneBidHelperLocalHome : i s
[ bidIncrement ] Integer I[Il ~].J10 ~uf =]
@ testMethods() maxBid & Long oo
©m  getBidHelperLocalHomed) userlD = Integer Ba201
currency L
ExpectedException x®
< | *

Outline | Properties

Tasks | Test Data Table |Error Log




IBM Software Group | Rational software

Debug: Understand behavior, performance & memory
utilization —

= What
» Runtime analysis
a Memory leak detection

Performance profiling
Code coverage measurement
Thread analysis

" | Execution flow visualization
» RSA/RAD-based support for Java

= For
» Developers
= Why

» Optimized reliability independent of
deployment-related concerns
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= What
» Manual test authoring,

2 outline 53 |R.eoentFiJes| i
= sell Fund &
----- 2| Launch Browser

I 1 ion 1 - }=l Enter Address http:/
Organlzatlon and exeCUtlon I:—]@ Logon For Trading +-g= Logon For Trading
----- FE NewName [+ = Navigate to Trading
----- + Confirm that the |- = Sell Mutual Fund
= For

----- 2| Enter User Name

TR
Eé?-}, Verify Transaction in
----- 2 Enter Password

. o - H % i
----- | Select Startin:® = Enter Addr - ihm. to the sho
» Businessanalysts | o oot bl ex Address hitp:/ i jbm com info the region shown
----- + Does the "Remer 2} IBM United States - Microsoft Intern|
» Testers :g E:;dfsrsm‘;.e ™ Fle Edt View Favortes Tooks Help

KRG,

----- 35‘ Logged in ok? P -
[—J@ Mavigate to Trading Q Cop @
" W h y ----- ¥l Click "Investing™ — =
----- ¥=| Click "Executions el

Address |

» Reduce impact of software
change and human error on
manual testing efforts

Enter User[D
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GUI Test Automation: Rational Functional Tester

= What

» Functional and regression test
automation

» Activity automation
= For
» Project specific QA teams
» Experienced testers
» GUI developers

= Why

» Ensure proper use case
implementation before deployment

» Support fact-based evaluations of
project readiness and application
quality

-
B

File  Edit

= & B
%‘ Solution

g —
| Solution 'Project?’ (1 project]
& Project1

| % | 1210)dx3 Ja s
T
i
-
8
3

E
Tr

' Frame: Member Logon
PasswordText () .Click (ActPoin
MemberLogon () . InputChars ("fo
RememberPassword () .ClickToStat
CE () .Click()}

' Data Driven Code inser

Ll
Tools
G, WW W H.
b Script2.vb | 4 I % || Script Coadorer 1 x
5 - Seript2
| |[=§TestM -
|| ain | o

nction TestMain (ByVal args() A= Object) -

thApp ("ClassicsJavah"™)

ame: Classics=CD

2 () .Click (AtPath ("Composers->Beethoven->
2().Click(AtPath ("Composers->Beethoven-»
PlaceOrder () .Click()

: Place an Order
unberIncludeTheSpa

i tCombo () . SetText (Dp.
ationDateText (|.5et
ext () .SecText ( tring

Test Datapool

Verification Points
Test Objects

CreditCombo

MemberLogon
MNameText
QK

t Tree2
il

CardiumberInc... | creditCombo Expira
a 444444444444 Visa 0505
123412341234 0208

.| MameText

StreetText

CityStateZipText | Ph

Private Test Object M
CardMumberIndudeTt
-3 CityStateZipText

| ClassicsJava

ExpirationDateText

)

-] Private Test Datapool

3

Trent Culpito
Brian Fred

Fowall st 22nd Fl MY, NY 12212
| NY, NY 12214 12
: ]

1212 Fooln

21

Z
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Performance Testing: Rationa

File Edt Mavigate Search Project

Iti-515 € [3%-0

| Performance Tester

= What
» Load and performance testing

Performance Test - ¢

Test Contents

This section shows the test cor

2% orderingstrawberrie

= For
» Testers

» Deployment Managers

= Why

» Validation of Web-application scalabili
under variable multi-user loads prior to

deployment

Shopping Cart

1) LoginPage H
Customer Info 5 2580
Shipping Address E
Subirit Order g
Crder Confirmation kS

o 1500
i)
T
£
=
2
4
13
g
&
o

i fresource/LoadTest_PrajectOnefLoadTestSchedue_One_1094679035634 51

Page Performanc

Auverage Pags Responss Time for Fun

655
[ Home Page

W Stawberies W Fuits

78 547 a2 2481

SubmitOrder [ Customerinio I Shopping Cat
Orde Corfimation [ Login Page

Summary | Page Performancs |Response vs, Tine | Pag

& Verfication Points | Page Element Verification Points |

r:(asks ‘ Recorder Control ‘ Protocol Data ‘ Mavigatar

Test Navigatar ‘

Statistical Data - Perfmon Agent at locahost [ PID:1072 ]

4 Cache (The Cache performance object consists of counters that monitor the Fe sys 4
% Processor (The Processor performance ohject consists of counters that measurs asp

53 % Pracessar Time (% Pracessar Time is the percentage of time that the proc
%03 % User Time (% User Time is the percentage of narvidle processor time sper
403 % Privileged Time (% Privisged Time s the percentage of non-idie pracassor
% Interrupts/sec {Interrupts/sec is the average number of hardware interrupts
&2 % DPC Time (% DPC Time is the percertage of time that the processor spen
%3 % Inkerrupt Time (% Interrupt Time s the percentage of time the processar
40 DPCs Queuedjsec (DPCs Queusdjsec is the overal rate at which dsferred pr

21 DPC Bypassesfsec (DPC Bypasses/sec is the rate at which deferred procedur
%0 APC Bypassesfsec (APC Bypassessec s the rate at which Kermel APC intern,
i Total ()
423 Memory (The Memory performance object consists of counters that describe the bel
%31 Obects (The Object performance object consists af counters that monitar Iugucaﬂj
3

&5 DPC Rate {DPC Rate s the rate at which deferred procedure calls (DPCs) are_J| ||

T
0%35:40

raphs | Controls | com
Mame

09:35:45 093359 09:36:00

Y Siider Multpler
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Monitoring: Tivoli TMTP and Tivoli Monitoring family

= What

» Cross-tier post-deployment performance
monitor

» Performance degradation detection
» Transaction decomposition
= For

» Deployment Managers
» IT Operations
= Why

» Early capture and analysis of performance
problems post-deployment
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements

» Workflow tools and servers heritage and enhancements
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Integrating People, Processes and Information

= Model your business, simulate a process and assess cost savings

""""."" ~ Connections k
BEN —
T

< I ’] ~ Annotation

Confirmat. .

@&

Connections
_..‘ ﬁ Achieve Final
. Risk Azsess L Approvel?
Annointion Business
L]
Mo

* Send Risk
Rejection

i.l] Resource Cost Analysis

| start Time

Total

Average Cosk Per Time Unit
Average One Time Cosk

Average Cost Per Quankity
— Average Cosk Per Quantity & Time Unit
Annual Per TimeUnit Cosk

Thursdaw, January 1, 2004 12:00:00 AM CST

$65.31 [/ 1 Hours
40,00

$590,163.93

= Describe everything as a web service and integrate using workflow tools

x|
. | Partner Links w= o l;
Yarishles = o Process ]
ProcessIN 5 - - EIsA [
Ao

CreatespplicationOUT
CreditCheckIM
CreditCheckoUT
Rulesppravell
RuleApprovetUT
LoanCfficerIN
LoanOFficerOUT
MotifyCustomerIN
MotifyCustomeroUT
ReserveFundsIM
ReserveFundsOoUT
RuleRiskissessIM

RuleRiskissessOUT

=

|
=l

Createapplication

=

]
=
=
PrepCreditCheck
° -
CreditCheck

=

CheckCredit ]

Autodpprove

MotifyCustomer | |

ReserveFunds ||

RuleRiskassess ||
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements

» Virtualized application server profiles enhancements
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WebSphere XD — Supporting On Demand, Mission Critical
Applications

o
=
©

£

=
>

e

TS

Responsiveness

» WebSphere Dynamic Operations

Virtualized and Automated Environment increase stability and reduces
TCO

Run more applications on a set of resources than possible with a static
configuration

Enhanced goals-based policy-driven Workload distribution

Allocating resources as needed to meet applications and business
goals

» WebSphere Extreme Computing — Application Partitioning

New APIs and tools, runtime and admin support for financial, banking,
reservations, on-line auctioning and gaming customers

Design Patterns for building high volume, scaleable and 99.999%
available, OLTP applications

» WebSphere Extended Manageability

» Operations Console

» Health Monitoring

= Task Management Service

B, << o
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Dynamic Operations

Stock I
i Trading 100%
C_Onv_entlonal ) Utilized Servers I
Distributed Environment —
: I
= Environment
» Multiple business critical — L
applications
» Hundreds of application servers 15%
Utilized Servers ]
= Challenges ——
» Underutilized servers
- I
» Inability to share resources across
server pools — especially during
peaks
. . . Portfolid
b Incqnsustenf[ quallty o_f service for Forecas 10%
business critical applications U] SeimvEs

» Human-intensive monitoring and
management environment
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Dynamic Operations

I
Stock
WebSphere Extended Trading m—r -
Deployment Environment [T
= Virtualized Customer [
Support
» Pooled resources ]
» Virtualized applications
Account
= Goals based Management
» Operational policies are attached to
Application to reflect operational goals Risk I
and importance of application Management
» Autonomic managers designed to
monitor environment for maximum
utilization using business goals Portfolio
Forecasting
= Results 55%*

» Help reduce total cost of ownership Utilized Servers
(doing more with same/less)

» Increase stability and repeatability of
environment

* Hypothetical, for illustrative purposes only
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Policies — Applying Business Goals to Applications

Stock Trading
Stock Trading

Very
RT < 1sec for < 10 TPS .
High
Account
Management
EEEEE— RT < 2sec for < 10 TPS
Portfolio

Medium
Forecasting

RT < 5sec for < 10 TPS
Customer

Medium
Support

Best Effort
Risk
Management
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WebSphere Integration Reference Architecture

WebSphere WebSphere DB2 Information WebSphere WebSphere
Portal Server Application Server Integrator Business Business
Integration Integration

Server Connect
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IBM/UMHS Briefing — June 2005

AGENDA - IBM Recommendations and Recent Product Enhancements

» |BM Premium Support enhanced level of service and responsiveness
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Application Development Tools

=» V6 Accelerated Learning €&
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[[rm]|

New Infocenter, including “Education Assistant”

« New Infocenter
http://fibm.com/software/
webservers/appserv/
infocenter.html

« Education Assistant

> Presentations
narrated with
sound

- Tutorials

> Reference
information

+ |nstalled with WAS
and on ibm.com

WebSphere Application Server Library - Microsoft Internet Explorer

File Edit View Favorites Tools Help

OBack \_) @ @ dj pSearch \';':\?Favorites @ 8' h;\-; T D "ﬁ

Address | http://ibm.com/software/webservers/appserv/infocenter.html

United States [chang

Home | Products | Services & soluti | t&d loads | My account

+ All software products Software i

cation Servers WebSphere cation Server

WebSphere Application Server

Features and benefits

e TN . oo oo

Library

[T software

Success stories o . .
WebSphere Application Server Version 6.0.x Information Center

News
Trials and betas Express - distributed platforms
ot oy Show [ ds

et -+ WebSphere
Application Server for
iSeries library

13 My

how | Hide

-+ WebSphere
Application Server
Express library

Documentation - Information center format
WebSphere Application Server Network Deplovment, Version 6.0.x IBM HTTE Server
WebSphere Help System plug-in: Network Deployment library
WebSphere Help System plug-in: Javadoc
Documentation - Book format

Migrating, coexisting, and interoperating (PDF)
Installing vour application serving environment (PDF) 5
Administering applications and their environment (PDF) library
Setting up the application serving environment (PDF)
Using the administrative clients (PDF)

Securing applications and their environment (PDF)
Developing and deploving applications (PDF)
Troubleshooting and support (PDF)

Evaluation and overview

Literature: Case studies, data sheets, and more

+

+

WebSphere
Application Server -
Edge Components

Server
- WebSphere App
Server Network
Deployment

- WebSphere Applicati
Server for iSeries

+

WebSphere Extended
Deployment library

-+ WebSphere Business
Integration Server

- WebSphere Application Foundation library

Server for /05
- WebSphere Extendad
Deployment

Tutorials, samples and demos -+ WebSphere Business
Integration Server
Foundation for z/05
library

1BM Education Assistant

Accessing the Samples Gallery (requires product installation)
Release notes

Release notes

- Rational Application
Developer for
WebSphere Software

« Rational Web
Developer for
WebSphere Software

» Macromedia ColdFusion
Mx for WebSphere

Supported hardware and software
Supported hardware and software
Supported hardware
Supported software
Papers and articles
WebSphere Application Server zone on developerWorks
. WebSphere Business WebSphere Developer Technical Journal
Integration Server M
Foundation Links recommended by product support
- WebSphere Industry Supplemental books
Solutions WebSphere Redbooks Domain

Related solutions
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Eile Edit View Favorites Tools Help

eﬂack = \_"J @ @ {;j ﬁSearch “-En:.;’l:avorites @ Bv hi_% < |_J ‘3

Address |@ http:/ fwwiw-306.ibm.com/ software/info/education/assistant/noflash. shtml

Select your configuration:

Please select a configuration e

Please select a configuration
IBM@WebSphere ® Application Server, V6.0 and V6.0.1

- - IBEM@WebSphere ® Application Server for /0S5, VE.0.1
IBM Education Assistant | |suvewebspheres Application Server, v
IBM @ Rational @ Application Developer, V6.0

Services & solutions | Support & downloads |

My acco

IEM Education Assistant

Software for the e-business on demand era

IEM Education Assistant provides an organized collection of self-study educational materials that are
simple, short, and focused. You can access content in several formats:

Related links:
« WebSphere training
and technical

enablement . . . .
Marrated Presentations - include audio explanation of the task or concept

ﬁ( Show Me Demonstrations - illustrate how to complete a specific task
@ Tutorials - step-by-step instructions to complete bigger or more complex tasks

Additional resources - links to product documentation, Redbooks, and whitepapers

How it works

The IBM Education Assistant user interface allows you to select yvour configuration and specify how vou
want to display links to the educational material. Clicking on an education module link presents a
navigational hierarchy of available educational content.

=+ Click here to go to the education modules
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“Education Assistant” — RAD V6 and WAS V6

IBM Education Assistant

IBM® WebSphere® Application Server V6.0 >

Overview and new features

T

e

IBM Education Assistant

IBM® Rational® Application Developer V6.0 >

0 Return to the IBM Education Assistant selection page

e New to WebSphere Application Server V6

[~ Architecture overview (7 min}

i [ o

[~ Topology and terminology (11 min}

el [ oo

— Topology and terminology - Express (5 min)

0l [E] seex

e Overview and new features

.| Main themes, product packaging and
development toals (11 min)

Nl [ oo

—  Overview of new features (18 min)

Rl [ s

@ Download the full content of this flow in zip

format

e lcon key

@ See all of the above topics in a list and provide feedback on this material

Overview and new features

6 Return to the IBM Education Assistant selection page

6 Icon key
e Cverview and new features

L Rational Application W6 Overview and new % ﬁ‘"' 780K

features (37 min

e Download the full content of this flow in zip format

6 See all of the above topics in a list and provide feedback on this material

e Click here to expand or collapse a category and see education flowcharts
% A technical overview that provides backaround on a topic

ﬁ( A guided demonstration that shows how to complete a specific task

@ Step by step instructions to follow for completing a task

ﬁ Additional reading material

ﬁu" Includes audio

To view PDF format, get Adobe Acrobat Reader
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“Education Assistant” — RAD V6 — Modules

IBM Education Assistant @

TR {
Select your configuration:

| IBM @ Rational ® Application Developer V6.0 v |

Select how to display results:

| Task based view |+

Click on links below to view educational material.

Application development IBM Rational Application Developer V6

Tool overview
Getting started
Eclipse overview

Data application

Developing applications with Service Data Objects (SDO)

Installation and migration Installation and migration

development
Developing applications for databases
XML application .
tevel t XML application development

Developing Java™ and J2EE applications with Unified
Markup Language (UML)
J2EE™ application

development Analyzing coding practices in Java and J2EE applications

J2EE Web and EJB™ development

Web services applications

Developing Web services applications

Securing Web services applications

Testing Web services applications

Developing Web applications (including 12EE Web

Testing applications with WebSphere Application Server
Ve

Web application applications)
t Developing Web applications with JavaServer™ Faces
(ISF)
Poﬂ:m:on Developing portal applications

Test, debug and profile Component testing applications
applications
Debugging Java and J2EE applications
Profiling Java and J2EE applications
Applying security Applying J2EE security to EJBs and Web applications
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“Education Assistant” — WAS V6 — Modules

IBEM Education Assistant

Related links:

- WebSphere training
and technical
enzablement

| IBM Education Assistant /Y d

5 4

Select your configuration:

[IBM® WebSphere © Application Server V6.0 v |

Select how to display results:

|Taskbased view v

Click on links below to view educational material.

Tasks IBM WebSphere Application Server V6 and V6.0.1 for

Distributed
L . L . .
T T = ST Big picture, overview, product packaging, new V6

features, topology and terminology

Installation (WebSphere Application Server, IBM HTTP
e EeeT 57 TR Server and Web server plug-in) and migration

WebSphere Application Server profiles

J2EE™ 1.4 programming model

JavaServer™ Faces (1SF) and Service Data Objects

{sDO)

Programming model
Web services
Programming model extensions (PME)
Svslemanlﬂmﬁcallmn System, application and Web Server plug-in management
Security Security architecture and details

Service integration

Service integration technology, including messaging

technologies
Scalability and high . PR .
P

availability Work load management and high availability details

Class loader and JNDI naming
Other runtime functions

Transport Channel Service

Performance Performance, caches and tools

Problem determination and

serviceability

Problem determination - overview and details
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&l wllEEHd

JavaDevTools.com IBM Links About Bill Hahn )\&

r® % [

< .
JavaDevTools.com A\ O@ Q,A 00
“Navigating WebSphere, Rational, Workplace and other IBM Eclipse Based Tools..." 6Q \ O 6 .
Homepage for: RationalCentral_com, WebSphereCentral_com, WorkplaceDev.com, JavaSOA_com. Bill-Hahn_com @, e \
S

Disclaimer: This is a private web site intended for IBM Eclipse Tools enthusiasts. The materials on this site are offered as-is, no
support, no warrantees. This is not an official IBM website. To achieve the official IBM experience, please visit hitp:/ibm.com.

Welcome! Rational Application Developer (RAD) is the foundation of the IBM Software Development Platform @
(SDP). The links, demes and presentations below can speed your navigation of IBM development tools. Q 6
Executives, managers, architects and developers can use this site to learn more about Rational, 3@» A@'

WebbSphere, Lotus and other IEM Eclipse-based development tools.

Featured Demo . \\/

o RAD V6 Introduction and Tour Demo @
This demonstration showcases RAD in action and concisely explains the breadth and depth of RAD V6.
Executives, managers, architects and developers can use this overview and the referenced resources
fo quickly learm about the power and value of RAD V6.

Most Popular Links

o Tutorial i i !
{Getling Started Guide, Introduction and Tou
Four scenarios with = 75 demos
1) End-2-End (Soup-to-nuts J2EE Build Scenarios)
2) Quick Success (Short Ad-hoc Build Scenarios, < 10 min each)
J) Banking and Finance (Web App/Site Scenario)
4) Financial Advisor Dashboard (Portal/Portlet Scenario)

0 Presentations and Seminar Demos (Downloads|

o Eclipse - Platform, Evolution, Ecosystem, and beyond [Article)

o Rational - IBM Software Development Platform (SDP) Overview (Whitepaper)
o WebSphere - IBM Enterprise Service Bus + WBI (Whitepaper)

o Workplace - IBM Workplace Overview and Resources (website)

o Portal DevZone - V5.0 Whitepaper and Portal V5.1 Enhancements

2005/03/24 Updates

o RAD V6 Tutorial Demo Series has arrived!
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RAD V6 Tutorial Demo Series

Executives and Managers

[[rm]|
I

» Watch and Learn: Simply view the “Tutorial Demo” movies to see ROI in action...in just minutes!

Architects and Developers

= Watch and Do: Use the “Tutorial Demo” movies to build the reference applications from scratch!

¥ 1 End-2-End Application

End-2-End Page (Eand2EcdPage jsp and juva)
Call Al
Trpe ol Calls  Tnpat->Submit-=Results Diagrems
o e | S 45:3}
Wel is-n r A
i i ?:dr o [ Cond  Clea i bk "“‘* ""“"" i
kg o ae) i oo | [City: | Long lsland Caty -
o FauWeather K;” WQI-I-FFIJHCKY! e | New Yok F_E} ’%
{ServiceObjects.com) == Tawf % ’l. =t R |
et Ebnas Preey et Sarvice.
i1 naFuge | wew StriceObpects com
| TN e o e
1& [z L r $ >
XAIL: T TR i nlmnm i XML Dos
‘o Create XML Doc :u . — -
o Recieve XML Doc ||| Submi o & ?\
C
ML <l version="1.0" encoding="UTF-§"7» <E1E> p e
Doc  <ID»123<1D> <INFO-Hi XMLI<INFO> <E2E> bl r‘:"i Enia
COUNTER couNT
CoumterA m
Counter 200
Page 1 o6 2 (] (vl Jump o page: | I -
JSF: - S | T -;.--—'_'
(Chemt-sicle data i - r -‘—‘-F =
o Tabile . Ll 2
o Graphs i L [ 1 J
"3 e il -
o

#¥2 Quick Success Apps

g oo (VIR
:

W= Banking & Finance

My baital w. i iy fla .lﬂl‘
LS n N :
s [ =
St A
s
b

Wit

ari ooy pural =8

I

nnnnn

[ i Rt | bt
» as.auol az amn

106080 1 | 4N
! 1500000 4 | dbn
N TRNONA 1R l A I) ﬂf
™ e 1 | s e
idrdh | a



IBM Software

RAD V6 Tutorial Demo Series — How They Work...

» The embedded movie player has playback controls like a DVD player.
* The SLIDER allows accelerated forward/reverse playback control. » & e « » o — j

lb T TR

a
| %

© Web - Web Browser - IBM Rational Software Development Platform

Magnified View of Slider Fle Edt Navigate Search Project Run Window Help
—_— IB-E@|srusdrimscE===MHEK |- | @& |ccro-|@ %[ @web

[&] BankCustomersView.jsp | T N . & Web Browser X

J Ihttp:mocaIhost:gﬂalprsfmyporta\f!utijs.?707Af?707407f.cmd!adf.arf1847068225f.pmf-f.CJELUJTBI.cef770740M.pf57073T1f.dfj B | LI ] Ol | l

BankCustomers portlet .. “

- BankCustomersy | [k

Cust # | First Name | Last Name Address City State Zip e-mail Work Phone

1 ° Arthur Platinum 123 Easy Strest Long Island Y 11101 |Cash.A.Plenty@mail.com |773-123-1111

2 [»] Betsy Golden 45 Plush Circle Arlington WA 22202 |Gold.P.Lated@mail.com |773-123-2222

3 g Charlie Silver 67 Humble Avenue |Fort Lauderdale |FL 33303 |Simply.E.Nuff@mail.com |773-123-3333 =
4 Denise Copper 89 Trailer Park Drive Burghill OH 44404 |Alvays.N.Debt@mail.com | 773-123-4444

BankPortfolios portlet BE

Bank Portfolio Management

|Custumer # |—‘|3 |

Analyze Custamer Portfolio |

Allocation | Graphics | Market Simulation |

Fund Name % of Folio | $ Invested | Risk | % Return | $ Projected
301 Blended - Income Flus Life Strategy 5% $25,000.00| 1 2.125% £25,331.25
302 Blended - Conservative Life Strategy 5% £25,000.00| 2 4.25% | $26,062.50 |
202 Elended - Moderate Life Strategy 5% $25,000.00| 2 6.375% £26,593.75
304 Blended - Aggressive Life Strategy 5% £25,000.00| 4 8.425% | $27,106.25
305 Money Market 5% $25,000.00 1 2.125% $25,331.23
ane Brnd - Stahla Walia 1no6 £sn nnnnnl 1 7 1750 | €51 n&D s el

i, i ] i,

|Paused |o0:59/01:06




End-2-End Application

Demo

“Accelerate development...
increase productivity...
maximize ROl !$! "

Iterative Development Demos
=> Model, Build, Test, Debug, Deploy

»  UML Model Visualizations
= Dynamic Development

+  Automated Deployment

J2EE+ Builder Demos
=>» Includes JSF, SDO, Web Services

« Java
s Databases
» \Web Services

+ Drag-n-Drop GUI
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Quick Success
Applications

Demo

s Easy build scenarios
s You watch or build

@ <10 minutes each

Banking & Finance

Web/Portal
Applications

Demo
= Banking Accounts

s Portfolio Management

@  Financial Advisor
Dashboard

ﬁ [ Navigation - QuickSuccess  REAVENGIGTE @ 8
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End-2-End Application

“Accelerate development...
increase productivity...
maximize ROl !$! "

Iterative Development Demos
=>» Model, Build, Test, Debug, Deploy
s UML Visualizations

+  Dynamic Development

s On-the-fly code changes

s Incremental build engine

« Testing for Java, EJBs, Web
Services, etc...

s Dynamic Interactive Debugger

s Automated Application
Packaging and Deployment

J2EE+ Builder Demos
=>Includes JSF, SDO, Web Services
s Java and EJBs (Session, CMP)
s Service Data Objects (SDO)

s SDO CMP Session Facades

s XML and XSD Schemas

s XML SDO JavaBean Bindings
s JavaServer Faces (JSF)

s Database and SQL

s \Web Services Creation and
Consumption

Y | P T -
[
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Quick Success Gallery Applications
= Easy J2EE build scenarios

= Internet Weather Web Service

= JavaBean Web Service

» EJB Web Service

= Service Data Objects (SDO)

= Database Mediator: Select, Insert, Update, Delete

= Java Server Faces (JSF)
= Rich Ul Controls, Charts/Graphs, drag-n-drop
= Custom coding, Event Driven, MVC Framework

Banking & Finance

Web/Portal Applications

= Transfer Funds

= Transaction History

> Account Management

> Portfolio Management

»  Asset Allocation

= Graphical portfolio analysis

= Stock Market Simulation

= Mutual Funds, Stocks, Bonds, Money Mkt

 Navigation - QuickSuccess X =

Home
658

QuickHome.jsp...
I T 1

Weather Java SDO CMP Facade JSF Page Data
58 58 5& eud
) | QuickWeather... QuicklavaWeb... QuickSDOCMP... QuickISFPageD...

EB EJB Web Service DB List JSF Client Data
*5& *5& LAl e5a

QuickEIB.jsp (/... | | QuickEIBWebS... QuickSDOdbLs... QuickJSFClient...

) OO Facaie : | DB Update
O oss

QuickSDOdbUp...

1 Navigation | Detail

\/\/ My Portal Administration [# Edit my profile [#] Log out
[ \/\\/\\,\/’\\,’“\\ New P s A P
W Finence

Financial Advisor

My Favorites E I

BankCustomers portlet -0
Dashboard ) 5 = i
T Financial Advisor's Dashboard
Customers
Cust # | First Name | Last Name City State Zip Work Phone | & Invested | £ Projected | % Rate of Return A
1 Arthur Platinum Long Island NY 11101 |773-122-1111($500,000.00 |$527,751.15|5.55%
2 Betsy Golden Arlington VA 22202 (773-123-2222|£500,000.00 ($527,568.75|5.5914%
3 Charlie Silver Fort Lauderdale |FL 33303 |773-123-3233 £500,000.00 |$526,688.75|5.238%
4 Denisa Copper Burghill OH 44404 |772-1232-4444 £500,000.00{$510,625.00|2.125%
Customer Portfolios Performance
6
54 =
18 =
= a s BEs8cSSEESSTSEES3
g 42 =
5 o B § Invested
B 36 = -
]
BankPartfolios portlet =t

Banking > Finance > Portfolio Management

—

Customer #

Analyss Custarmer Doetialin |

Portfolio details for Arthur Platinum appear below:
Invested: |$500,000.00 Projected: |$527,751.15 |Rate of return: |5.55%

Allocation | Graphics Market Simulation
Fund Acct = Fund Name % of Folio | 3 Invested | Risk | % Return | § Projected
101 Blended - Incoms Plus Lifs Strategy 5% | $25000.00) 1 | 2.124% | $25,531.00
102 Blended - Conservative Life Strategy| 4% | $20,000.00| 2 | 4.249% | $20,849.80
103 Blended - Moderate Life Strategy 6% |$30,000.00 3 | 6.374% | $31,912.20
104 Blended - Aggressive Life Strategy 7% | $35,000.00 4 | B.424% | $37,948.40
105 Money Market 5% | $25,000.00 1 | 2.124% | $25,531.00
106 Bond - Stable Value 3% | $15,000.00 1 | 2.125% | $15,316.75
107 Bond - Total Market 5% |$25.000.00 2 | 6.375% | $26,593.75



IBM Software Group | WebSphere software

Resources

iIbm.com/developer
(IBM developerWorks for technologies and products)

= jbm.com/developer/websphere
(WebSphere Developers Domain)

= ibm.com/developer/rational
(WebSphere Developers Domain)

> ibm.com/developer/iom
(All other product developer domains)

www.redbooks.ibm.com
(How To Books)

ibm.com/software/ad
(IBM App Dev Tools Homepage)

ibm.com/websphere
(WebSphere Family Homepage)

JavaDevTools.com (a.k.a. WebSphereCentral.com, RationalCentral.com)
(Presentations, references, tutorials, white papers, articles, links, etc.)
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